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 ABOUT THIS GUIDE

This User Guide is a reference for the EZ Mask masking tool. You can read 

from start to finish or just jump around as you please.

Copyright
EZ Mask is based on unpublished research and technology by Jue Wang from 

the Department of Electrical Engineering at the University of Washington. 

No part of this document may be reproduced or transmitted in any form or by 

any means, electronic or mechanical, including photocopying and recording, 

for any purpose without the express written consent of Digital Film Tools.

Copyright © Digital Film Tools, LLC. 2015. All Rights Reserved

March 12, 2015

About Us
Digital Film Tools brings together the unbeatable combination of superior 

software designers, motion picture visual effects veterans, video editors and 

photographers. Add three Emmy Awards and experience in creating visual 

effects for hundreds of feature films, commercials and television shows and you 

have a recipe for success. The understanding of photography, film and video 

editing, and in particular visual effects, allows us to design productive and 

highly specialized software. Software that is useful as well as easy to use. Our 

products stand up to the rigors of production and are the culmination of many 

years of experience.

Our philosophy is to bring our visual effects tools and techniques to the 

masses. What was once found only in expensive high-end packages or existed 

as proprietary in-house tools, is now available to photographers, artists, 

designers, and video/film editors. Did I mention affordable? Our software 

doesn't cost an arm and a leg and won't break the bank.
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 EZ MASK

Introduction
EZ Mask is an easy to use interactive image masking tool capable of extracting 

almost any object in an image--even if you are dealing with fine hair detail, 

smoke, or reflections. This extraction process creates what is known as a 

mask--essentially a black and white cutout. White mask areas are extracted, 

black areas are not, and gray areas in between represent a level of 

transparency. Once a mask is extracted, the foreground object can be 

seamlessly composed onto a new background.

To work this magic, EZ Mask iteratively estimates the transparency value for 
every pixel in the image, based on a small sample of foreground (what you want 
to cut out) and background pixels marked by simple strokes on the image. 
There is even a Refine mode where EZ Mask automatically updates the mask 
or composite as you paint a stroke. Results show that compared with previous 

Before After

Mask User Input
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approaches, our method is more efficient and requires minimal effort to extract 
high quality masks for foregrounds with significant semi-transparent regions. In 
addition, the foreground colors are estimated in the semi-transparent areas to 
create a seamless composite.

Features
• Stroke based masking

• Capable of extracting almost any object in an image

• Excels with fine hair detail, smoke, or reflections

• Interactive Refine mode to finesse the mask

• Edge color estimation prevents fringing to create a seamless composite

• Blue/Green spill suppression

• Foreground color correction, position, scaling, rotation and corner-pinning
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 INSTALLATION

1 Download EZ Mask at www.digitalfilmtools.com

2 Double-click on the file that was downloaded and run through the installation 
process.

3 When prompted, select the destination programs to install into. You can choose 
from Photoshop, Photoshop Elements, and Lightroom.

4 Load or select an image.

• Photoshop/Elements: Select a layer that contains a layer mask.

• Lightroom: Select two images if you want to composite one over the other, 
otherwise select one image.

5 Apply EZ Mask:

• Photoshop/Elements: In the Filter menu, select EZ Mask from the Digital Film 
Tools group.

• Lightroom: In the Photo menu, select Edit In and then choose Edit in EZ Mask.

A dialog box pops up when you run EZ Mask.

6 If you purchased the software, select Activate EZ Mask and follow the 
instructions.

or 

7 Select Request Trial Activation (Internet Required) and click Next to receive a 
fully functioning version of EZ Mask for the specified trial period. At the end of 
the trial period, EZ Mask reverts to a limited demo mode.

or

8 Select Run in Demo Mode and click Finish.

Note: In Demo Mode, a watermark is superimposed over the image.
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Adding EZ Mask to Lightroom as an External Editor
If Lightroom is found during the installation of EZ Mask, EZ Mask will 

automatically be added as an external editor. If for some reason EZ Mask does 

not show up as an external editor, you can manually add EZ Mask as an 

external editor by following the steps below.

1 Open the Preferences in Lightroom.

2 Click the External Editing tab.

3 In the Additional External Editor section, select TIFF for File Format, sRGB for 
Color Space, 8 or 16 bits/component for Bit Depth, set the desired Resolution, 
and choose None for Compression.

Note: EZ Mask is only compatible with TIFF files (8 or 16-bit, with no compression).

4 Click on Choose to select an application. Navigate to the location of EZ Mask.

• On Windows, the default installation location for EZ Mask will be: C:\Program 
Files\Digital Film Tools\EZ Mask v3.0

• On Macintosh, the default installation location for EZ Mask will be: /Macintosh 
HD/Applications/Digital Film Tools/EZ Mask v3.0

5 Select the EZ Mask file and click Choose.

6 Under the Preset drop-down menu, select Save Current Settings as New Preset… 
and name the preset EZ Mask.

EZ Mask can now be easily accessed under the Photo menu as a preset 

external editor.
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 UNINSTALLING

Windows
From the Windows Start Menu, select Programs > Digital Film Tools > EZ Mask 

v3.0 > Uninstall EZ Mask.

Macintosh
Go to Applications/Digital Film Tools/EZ Mask v3.0 and double-click on 

Uninstall EZ Mask.
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 ACTIVATING, DEACTIVATING AND 
TRANSFERRING LICENSES

Activation Options

Internet Activate
Activates EZ Mask over the Internet.

Request License from Self-Service Website
If you do not have an Internet Connection on the computer where you want to 

run EZ Mask, use this option. The self-service website will generate a license 

file which you can then transfer to the desired computer.

Install a License File
Loads a license file obtained from the self-service website or received by email.

Note: If you experience an error when using Internet Activate, it is because you or your 
company uses a proxy server to access the Internet and/or your firewall is blocking our 
program’s access to the Internet. For proxy server users, select Advanced Options and 
enter the appropriate proxy server settings. For firewall users, open your firewall 
software and allow our software to access the Internet.

Deactivation Options
Once EZ Mask has been activated, you can access the Deactivation Options 

by selecting the License menu.

Internet Deactivate
Deactivates EZ Mask over the Internet and is only available if you initially 

activated over the Internet. Use this method to return your Product Code back 

to the activation server. You will then be able to use your Product Code to 

activate EZ Mask on another computer.

To deactivate EZ Mask:

1 Select License from the Help menu.

2 Choose Internet Deactivate and click Next.
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License Transfer
Your Product Code allows you to run EZ Mask on one computer at a time. 

However, you may transfer the license by deactivating on one computer and 

activating on another.

Internet Deactivate / Internet Activate is the preferred method of license 

transfer between computers, but is only available if you initially activated over 

the Internet and currently have Internet access. If you do not have Internet 

access, you will need to contact customer support to assist you in transferring 

the license.

To transfer a license:

1 Select License from the Help menu.

2 Choose Internet Deactivate and click Next.

EZ Mask is now deactivated.

3 On the target computer, select Activate EZ Mask and follow the instructions.

EZ Mask will then activate on the new computer.
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 TUTORIALS

Applying EZ Mask

Lightroom
1 Select two images if you want to composite one over the other, otherwise select 

one image.

Multiple images can be selected by using Ctrl(Win)/Cmd(Mac)-clicking on 

images.

2 In the Photo menu, select Edit In and then choose Edit in EZ Mask.

When using two images, Lightroom may swap the order of the foreground and 

background images when bringing them into EZ Mask.

3 If necessary click the Swap Foreground/Background icon so that the image you 
want to mask is visible.

Note: If you apply EZ Mask to a single image in Lightroom, you will need to edit/export 
using the original setting instead of copy to gain access to the generated alpha 
channel.

Photoshop
Using EZ Mask with a Background & Foreground Image
EZ Mask normally works with two images: a foreground and a background. 

Before applying EZ Mask, you should place your foreground image in a layer 

above the background image.

Note: The layer below the one that you applied EZ Mask to is automatically used as 
the background.

1 Load foreground and background images.

2 Click on the foreground image and press Ctrl(Win)/Cmd(Mac)-A to select it and 
Ctrl(Win)/Cmd(Mac)-C to copy it.

3 Click on the background image and press Ctrl(Win)/Cmd(Mac)-V to paste it.
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4 Press the Add Layer Mask icon at the bottom of the Layers Palette.

A solid, white Layer Mask shows up to the right of the foreground image. 

5 In the Layers Palette, click on the foreground layer’s color image to select it (not 
the Layer Mask) before applying EZ Mask.

The layers are now properly setup so EZ Mask can be applied.

6 From the Filters pull-down menu, select EZ Mask v3.0 from the Digital Film Tools 
group.
Dfx User Guide    
• 
• 
•
•
•



• 

Tutorials  12 

• 
• 
• 
•
•
•

Using EZ Mask with a Single Image
EZ Mask normally works with two images, but a single image can be used as 

long as it has a Layer Mask. When you load a single image in Photoshop, it 

shows up as a locked Background layer in the Layers Palette. To add a Layer 

Mask, you will need to unlock this Background layer.

1 Load an image.

2 Double-click on the Background layer in the Layers Palette.

3 When the New Layer window opens, press OK.

Double-clicking on the Background layer in the layers palette simultaneously 

converts it to a layer and unlocks it.

4 Press the Add Layer Mask icon at the bottom of the Layers Palette.
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A solid, white Layer Mask shows up to the right of the image. Photoshop uses 

the Layer Mask to place one image over another. 

5 In the Layers Palette, click on the foreground layer’s color image to select it (not 
the Layer Mask) before applying EZ Mask.

The layer is now properly setup so EZ Mask can be applied.

6 From the Filters pull-down menu, select EZ Mask v2.0 from the Digital Film Tools 
group.

Note: When EZ Mask processes, it overwrites both the color and layer mask portions 
of the foreground layer. For Photoshop to composite your result, you will need to load 
a background image and position it below your EZ Mask processed layer.
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Dog Tutorial
EZ Mask creates masks by using a trimap--a pre-segmented image consisting 

of three regions of foreground (what you want to cut out), background and 

unknown. Partial opacity values are then computed only for pixels inside the 

unknown region. Two trimap methods can be used: Stroke and Filled. This 

tutorial will use the preferred Stroke method.

Unlike previous approaches, our trimaps can be relatively sparse consisting of 

individual foreground and background brush strokes. All pixels left unmarked 

will be treated as unknown. After processing, if any fine foreground details are 

missing from the mask, the Missing brush can be used in these areas to help 

recover lost detail.

1 Go to www.digitalfilmtools.com and download the EZ Mask tutorial images from 
the download tab.

2 Load the dog.jpg foreground and dog_bg.jpg background images.

3 Apply EZ Mask to the dog foreground and background images.

See the Applying EZ Mask tutorial for more information.

4 From the Filters pull-down menu, select EZ Mask v3.0 from the Digital Film Tools 
group.

A good stroke technique is to draw an inner outline around the object you are 

extracting using the Foreground brush and an outer outline using the 

Background brush.

Foreground Background
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5 Define the area to be cutout by drawing foreground lines with the left mouse 
button. You can quickly draw straight lines if you click with the left mouse button, 
press Shift and then click in a different location. If you keep Shift depressed while 
clicking, you will create interconnected straight lines.

The Foreground brush (F) is selected by default when you enter EZ Mask and 

that is why you can just start drawing with the left mouse button.

6 You can change the brush size by using the Bracket [ ] keys, Up/Down Arrow 
keys or the Brush Size icon.

The strokes should be near the boundary of the foreground, but not right up 

against the edge. Strokes that are closer to the boundary will dominate the 

creation of the mask. Also, if the foreground has varying colors, the strokes 

should cover these colors.

7 Define background areas by selecting the Background brush (B) and draw with 
the left mouse button.

or
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8 Alternatively, you could specify background areas by drawing with the right 
mouse button.

If the background has varying colors, the strokes should cover these colors.

Warning: If you only provide a few sparse strokes, a Stroke trimap will take longer to 
process than a filled trimap.

Note: The general rule is don’t put different stroke types too close together unless you 
need to.

9 Click the Process icon.

EZ Mask process at the current Preview Quality setting, the default being set 

to 1024 pixels.The higher the setting, the longer the preview will take. The 

Preview Quality is changed by clicking the Options icon and selecting a new 

resolution.

Good Stroke Example Bad Stroke Example
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10 For now, leave the Preview Quality Set to 1024.

Once EZ Mask is done processing, the mask will be shown.

11 Use either the Left/Right Arrow keys or the F2, F4 and F5 keys to quickly compare 
the Foreground, Mask and Composite views. This helps identify problem areas 
in the mask.

An alternative method to comparing the different views is to use the Vertical and 

Horizontal Split Comparison icons which allow you to compare two images 

using a split screen.

12 Make sure that the Mask view (F4) is selected.

13 Click the Vertical Split Comparison icon above the Viewer.

The mask is placed on the left side of the split and the foreground to the right.
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14 Move your cursor into the image area over the split line and when the cursor 
changes to a double-arrow, click and drag to move the split.

This will help you identify any areas in the mask that need to be adjusted.

Note: The right side of the split can be changed by selecting a different view.

15 Click the Vertical Split icon again to remove the split.

Here are few tips on creating a high quality mask:
• Where there is solid background, the mask should be completely black.

• Where there is solid foreground, the mask should be completely white. 

• Where there are transparent or unknown areas, the mask should have gray values. 

From this point forward, you could draw additional foreground and background 

strokes and click Process to complete the mask. However, Refine mode allows 

you to interactively draw strokes and automatically render the result. We feel 

that this is the best and fastest way to refine your mask.

Note: In the following steps, your results will most likely differ than the screen shots as 
the state of the mask is totally dependent on where the brushes were applied.

16 Make sure you are still viewing the mask (F4).

17 Click on the Refine icon (R).

Refine mode changes the behavior of the Foreground, Background, Unknown and 
Missing brushes so that they are interactive. As you paint a stroke, Refine mode 
automatically updates the mask or composite.
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18 If you see gray areas in the foreground object that should be completely white, 
make additional marks with the Foreground brush (F).

Once the stroke is drawn, the area is automatically re-rendered.

19 If you see gray areas in the background that should be completely black, make 
additional marks with the Background brush (B). For instance, I see some gray 
areas in the background near the dog’s ear on the right side of the screen.

Certain foreground details may be missing after the mask is generated. Using 

the Missing brush in these areas can sometimes help recover lost detail.

Before After

Before After
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20 Switch between View Foreground (F2) and View Mask (F4) to see the what 
foreground details may be getting lost. When done, make sure you are viewing 
the foreground (F2).

21 If any fine foreground details are missing from the mask, click on the Missing 
brush (M) and draw over them with the left mouse button.

The purple colored strokes represent the missing areas.

22 Select the View Composite icon (F5) to see the foreground composited over the 
background based on the generated mask.

If the edge of the Dog becomes too hard as a result of the strokes made in 

Refine mode, you may see white areas from the sky in the edge areas. You can 

fix this by painting over the offending edges with the Unknown brush.
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23 Select the Unknown brush (U) and paint along the bright edge.

24 Click the Options icon and set the Preview Quality to Full.

EZ Mask re-processes the mask at full resolution. At full resolution, you are 

likely to see some areas in the mask that need to be adjusted because more 

detail can be seen.

25 If needed, make any necessary adjustments in Refine mode using the various 
brushes.

26 You may find it useful to zoom in and pan around the image using keyboard 
shortcuts as you are refining the mask. Go to the Zoom/Pan Keyboard Shortcuts 
for a full list of shortcuts.

Before After
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27 View the composite (F5) for one last check of your work.

Once you are happy with the mask that is generated and if the composite looks 

good, you can transfer the result to back to the host application.

28 Click Done to return to your host application.

Since the Preview Quality is set to Full, pressing the Done icon exits EZ Mask 

and returns to the host application without rendering. Rendering is only needed 

when the Preview Quality is set to a level other than Full. When rendering is 

needed, the progress meter pops up until the process is completed.
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In Photoshop, EZ Mask overwrites the foreground layer in addition to rendering 

a mask into the Layer Mask. This results in the dog foreground being 

composited over the dog background layer. In Lightroom, the resulting 

composite is rendered since it does not support layers.

Note: When working with both a foreground and background in Lightroom, a duplicate 
copy of the background will appear after rendering. You will need to manually delete 
this duplicate background copy.

29 If you are not happy with your results, press Ctrl(Win)/Cmd(Mac)-Z to Undo EZ 
Mask and try again.

30 When you re-apply EZ Mask, you will be asked if you would like to use the 
previous trimap. Select Yes to pickup where you left off.

Note: Since Refine mode was used the last time you were in EZ Mask, answering yes 
to “Use Previous Trimap” loads an optimized Filled trimap even if you previously started 
with a Stroke trimap.
Dfx User Guide    
• 
• 
•
•
•



• 

Tutorials  24 

• 
• 
• 
•
•
•

Alpaca Tutorial
EZ Mask creates masks by using a trimap--a pre-segmented image consisting 

of three regions of foreground (what you want to cut out), background and 

unknown. Partial opacity values are then computed only for pixels inside the 

unknown region. Two trimap methods can be used: Stroke and Filled. This 

tutorial will use the Stroke method.

Unlike previous approaches, our trimaps can be relatively sparse consisting of 

individual foreground and background brush strokes. All pixels left unmarked 

will be treated as unknown. After processing, if any fine foreground details are 

missing from the mask, the Missing brush can be used in these areas to help 

recover lost detail.

1 Go to www.digitalfilmtools.com and download the EZ Mask tutorial images from 
the download tab.

Foreground Stroke Trimap
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2 Load the alpaca.jpg foreground and alpaca_bg.jpg background images.

3 Apply EZ Mask to the alpaca foreground and background images.

See the Applying EZ Mask tutorial for more information.

4 From the Filters pull-down menu, select EZ Mask v3.0 from the Digital Film Tools 
group.

A good stroke technique is to draw an inner outline around the object you are 

extracting using the Foreground brush and an outer outline using the 

Background brush.

5 If you just completed the Dog tutorial, the Preview Quality would have been set 
to Full. Click the Options icon and make sure that it is set to 1024.

The higher the Preview Quality, the longer the preview will take.

6 Define the area to be cutout by drawing foreground lines with the left mouse 
button. You can quickly draw straight lines if you click with the left mouse button, 
press Shift and then click in a different location. If you keep Shift depressed while 
clicking, you will create interconnected straight lines.

Foreground Background
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The Foreground brush (F) is selected by default when you enter EZ Mask and 

that is why you can just start drawing foreground with the left mouse button.

7 You can change the brush size by using the Bracket [ ] keys, Up/Down Arrow 
keys or the Brush Size icon.

The strokes should be near the boundary of the foreground, but not right up 

against the edge. Strokes that are closer to the boundary will dominate the 

creation of the mask. Also, if the foreground has varying colors, the strokes 

should cover these colors.
Dfx User Guide    
• 
• 
•
•
•



• 

Tutorials  27 

• 
• 
• 
•
•
•

8 Define background areas by selecting the Background brush (B) and draw with 
the left mouse button.

or

9 Alternatively, you could specify background areas by drawing with the right 
mouse button.

Note: The general rule is don’t put different stroke types too close together unless you 
need to.

10 Click the Process icon.
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Once EZ Mask is done processing, the mask will be shown.

11 Use either the Left/Right Arrow keys or the F2, F4 and F5 keys to quickly compare 
the Foreground, Mask and Composite views. This helps identify problem areas 
in the mask.

An alternative method to comparing the different views is to use the Vertical and 

Horizontal Split Comparison icons which allow you to compare two images 

using a split screen.

12 Make sure that the Mask view (F4) is selected.

13 Click the Vertical Split Comparison icon above the Viewer.
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The mask is placed on the left side of the split and the foreground to the right.

14 Move your cursor into the image area over the split line and when the cursor 
changes to a double-arrow, click and drag to move the split.

This will help you identify any areas in the mask that need to be adjusted.

Note: The right side of the split can be changed by selecting a different view.

15 Click the Vertical Split icon again to remove the split.

Here are few tips on creating a high quality mask:
• Where there is solid background, the mask should be completely black.

• Where there is solid foreground, the mask should be completely white. 

• Where there are transparent or unknown areas, the mask should have gray values. 
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From this point forward, you could draw additional foreground and background 

strokes and click Process to complete the mask. However, you could use 

Refine mode to interactively draw strokes and automatically render the result. 

We feel that this is the best and fastest way to refine your mask.

Note: In the following steps, your results will most likely differ than the screen shots as 
the state of the mask is totally dependent on where the brushes were applied.

16 Make sure you are still viewing the mask (F4).

17 Click on the Refine icon (R).

Refine mode changes the behavior of the Foreground, Background, Unknown and 
Missing brushes so that they are interactive. As you paint a stroke, Refine mode 
automatically updates the mask or composite.

18 If you see gray areas in the foreground object that should be completely white, 
make additional marks with the Foreground brush (F).

Once the stroke is drawn, the area is automatically re-rendered.

Before After
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19 If you see gray areas in the background that should be completely black, make 
additional marks with the Background brush (B).

When drawing a stroke trimap, certain foreground details may be missing after 

the mask is generated. Using the Missing brush in these areas can sometimes 

help recover lost detail.

20 Switch between View Foreground (F2) and View Mask (F4) to see the what 
foreground details may be getting lost. When done, make sure you are viewing 
the mask (F4).

Before After
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21 If any fine foreground details are missing from the mask, such as areas of 
missing Alpaca hair, click on the Missing brush (M) and draw over them with the 
left mouse button. For instance, I see some missing hair in the middle of the 
Alpaca’s body on the right side of the screen.

If the edge of the Alpaca becomes too hard as a result of the strokes made in 

Refine mode, use the Unknown brush to soften the edge.

22 Select the Unknown brush (U) and paint along the hard edge.

Before After

Before After
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23 Select the View Composite icon (F5) to see the foreground composited over the 
background based on the generated mask.

24 Press Zoom to Fit icon to see the entire image in the Viewer.

I know, I know. The Alpaca is too high in the frame. You will move it down in a 

moment.

25 Click the Options icon and set the Preview Quality to Full.

EZ Mask re-processes the mask at full resolution. At full resolution, you are 

likely to see some areas in the mask that need to be adjusted because more 

detail can be seen.

26 If needed, make any necessary adjustments in Refine mode using the various 
brushes.

27 You may find it useful to zoom in and pan around the image using keyboard 
shortcuts as you are refining the mask. Go to the Zoom/Pan Keyboard Shortcuts 
for a full list of shortcuts.

28 View the composite (F5) for one last check of your work.

The alpaca appears to be too high in the frame.

29 Enable the DVE controls in the Effect Parameters window so that the alpaca can 
be repositioned.

Note: When the DVE is enabled, the strokes are hidden. This is because the strokes 
will no longer match up once the foreground element is transformed. At any time, you 
can temporarily disable the DVE controls once they are adjusted if you need to modify 
the strokes.
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30 Click and drag the Alpaca down in the frame for a better composition using the 
center cross-hair on-screen control.

You can also adjust the color of the alpaca, if so desired, using the Color 

Correction controls.

31 Click Done to return to your host application.
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Since the Preview Quality is set to Full, pressing the Done icon exits EZ Mask 

and returns to the host application without rendering. Rendering is only needed 

when the Preview Quality is set to a level other than Full. When rendering is 

needed, the progress meter pops up until the process is completed.

In Photoshop, EZ Mask overwrites the foreground layer in addition to rendering 

a mask into the Layer Mask. This results in the alpaca foreground being 

composited over the alpaca background layer. In Lightroom, the resulting 

composite is rendered since it does not support layers.

Note: When working with both a foreground and background in Lightroom, a duplicate 
copy of the background will appear after rendering. You will need to manually delete 
this duplicate background copy.
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 EZ MASK USER GUIDE

Description
EZ Mask is an easy to use interactive image masking tool capable of extracting 

almost any object in an image--even if you are dealing with fine hair detail, 

smoke, or reflections. This extraction process creates what is known as a 

mask--essentially a black and white cutout. White mask areas are extracted, 

black areas are not, and gray areas in between represent a level of 

transparency. Once a mask is extracted, the foreground object can be 

seamlessly composed onto a new background as well as apply filter and image 

corrections only within the area defined by the mask.

To work this magic, EZ Mask iteratively estimates the transparency value for 

every pixel in the image, based on a small sample of foreground (what you want 

to cut out) and background pixels marked by simple strokes on the image. 

There is even a Refine mode where EZ Mask automatically updates the mask 

Before After

Mask User Input
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or composite as you paint a stroke. Results show that compared with previous 

approaches, our method is more efficient and requires minimal effort to extract 

high quality masks for foregrounds with significant semi-transparent regions. In 

addition, the foreground colors are estimated in the semi-transparent areas to 

create a seamless composite.

User Interface
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Trimaps and Mask Creation
EZ Mask creates masks by using a trimap--a pre-segmented image consisting 

of three regions of foreground (what you want to cut out), background (what you 

want to get rid of) and unknown (neither full foreground or full background). 

Partial opacity values are then computed only for pixels inside the unknown 

region. Two trimap methods can be used: Stroke and Filled. However, the 

preferred and faster method is to create a Stroke trimap.

Stroke Trimap
Unlike previous approaches, our trimaps can be relatively sparse consisting of 

individual foreground and background brush strokes. All pixels left unmarked 

will be treated as unknown. After processing, if any fine foreground details are 

missing from the mask, the Missing brush can be used in these areas to help 

recover lost detail.

Stroke Trimap Creation Tips & Tricks
• Make sure you place enough foreground and background strokes. A good stroke 

technique is to draw an inner outline around the object you are extracting using 
the Foreground brush and an outer outline using the Background brush.

• The strokes should be near the boundary of the object, but not right up against the 
edge.

• Strokes that are closer to the boundary will dominate the creation of the mask. 

• If the foreground or background has varying colors, the strokes should cover 
these colors.

Strokes Mask
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• When drawing a Stroke trimap, it is not necessary to use the Unknown brush 
because EZ Mask considers any areas not marked as either foreground or 
background as unknown.

• After processing the mask, if you see gray areas in the foreground object that 
should be completely white, make additional foreground marks in those areas.

• If you see gray mask areas in the background that should be completely black, 
make additional background marks.

• If any fine foreground details are missing from the mask, click on the Missing 
brush and draw over them with the left mouse button. This instructs EZ Mask to 
pay special attention to these areas and will help recover lost detail.

• The general rule is don’t put different stroke types too close together unless you 
need to.

Warning: If you only provide a few sparse strokes, a Stroke trimap will not be accurate 
and take longer to process.

Good Stroke Example Bad Stroke Example
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Filled Trimap
The use of Filled trimaps has been retained from earlier versions of EZ Mask. 

However, the preferred and faster method to arrive at a finished mask is to first 

create a Stroke trimap and then use Refine mode to fine tune the result.

Filled trimaps are created by using foreground and background brush strokes 

to mark definite foreground and background pixels while the Unknown brush is 

used to mark unknown, or mixed regions. Using this method, the entire image 

is painted/filled with one of the three brushes. After processing, if any fine 

foreground details are missing from the mask, the Missing brush can be used 

in these areas to help recover lost detail.

Filled trimaps result in extracting accurate masks, most notably when color 

ambiguity exists between the foreground and background. However, they can 

be tedious to create and tend to fail for images with large portions of semi-

transparent foreground where the trimap is difficult to create manually.

Filled Trimap Creation Tips & Tricks
• First, define unknown areas by selecting the Unknown brush and drawing around 

the edges of the foreground (what you want to cut out) with the left mouse button. 
Include as little solid foreground areas as possible.

• Ideally, the unknown region in the trimap should only cover transparent pixels 
whose actual values are not completely foreground or background. In other 
words, the unknown region in the trimap should be as thin as possible to achieve 
the best masking result.

• Next, fill in the solid foreground area by selecting the Foreground brush and the 
Fill tool. Click inside the area defined by the blue, Unknown brush. The foreground 
area automatically fills in with the green foreground color.

Filled Mask
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• Last, mark background areas by using the Background brush and the Fill tool. 
Since the Fill tool is already enabled, you don’t need to select it again. Click 
outside of the area defined by the blue, Unknown brush. The background area 
automatically fills in with the red background color.

• After processing the mask, if any fine foreground details are missing from the 
mask, click on the Missing brush and draw over them with the left mouse button. 
This instructs EZ Mask to pay special attention to these areas and will help recover 
lost detail.

Load and Save Trimap
Trimaps can be saved and reloaded using File > Save Trimap and Load Trimap.

Use Previous Trimap
When you start EZ Mask, it will ask if you would like to use the previous trimap. 

If you last used Refine mode while in EZ Mask and answer yes to “Use 

Previous Trimap”, an optimized Filled trimap that EZ Mask last used to process 

the mask will be loaded.
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Brushes

Foreground (F)
The Foreground brush is used to mark the foreground area--the region to be 

cutout. With each click and drag of the mouse, a green line is drawn.

When Refine mode is enabled, using the Foreground brush updates the mask 

or composite in real-time.

Note: If you click with the left mouse button, press Shift and then click in a different 
location, a straight line is drawn. This will work with any brush type. If you keep Shift 
depressed while clicking, you will create interconnected straight lines. This is very 
useful when drawing with a mouse.

Background (B)
The Background brush is used to mark the background area--the region to be 

removed. With each click and drag of the mouse, a red line is drawn.

When Refine mode is enabled, using the Background brush updates the mask 

or composite in real-time.

Note: You can quickly create background strokes without selecting the Background 
brush by painting with the right-mouse button. This temporarily draws with the 
Background brush and when the right-mouse button is released, the previously 
selected brush becomes active.

Unknown (U)
The Unknown brush is used to mark the unknown areas--regions that are 

neither full foreground or full background. With each click and drag of the 

mouse, a blue line is drawn.

When Refine mode is enabled, using the Unknown brush updates the mask or 

composite in real-time.
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Stroke Trimap
When drawing a Stroke trimap, it is not necessary to use the Unknown brush 
because EZ Mask considers any areas not marked as either foreground or 
background as unknown.

Filled Trimap
When drawing a Filled trimap, the unknown region in the trimap should only 
cover transparent pixels whose actual values are not completely foreground or 
background. Partial opacity values are then computed only for pixels inside the 
unknown region. 

Missing (M)
The Missing brush is used to mark missing foreground areas--fine details such 

as strands of hair that may be missing after the mask is generated. Using the 

Missing brush in these areas can sometimes help recover lost detail. With each 

click and drag of the mouse, a purple line is drawn.

When Refine mode is enabled, using the Missing brush updates the mask or composite 

in real-time.

Note: The Missing brush has a Sensitivity parameter located in Preferences > 
Processing. It’s preset value will work for most images. However, the higher the value, 
the more details are brought out.

Eraser (E)
Erases existing brush strokes.

Note: The Eraser is not available in Refine mode.

Fill (Shift-F)
Using the current brush, the Fill tool fills a region defined by a brush stroke or 

the edges of the screen.

Note: The Fill brush is only necessary for Filled trimaps and is not available in Refine 
mode.
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Brush Parameters
Size (Up/Down Arrows or Bracket [ ] Keys)
Sets the size of the brush.

Opacity
Sets the opacity of the brush.

Brush Keyboard Shortcuts

Shortcut Action

F Selects the Foreground brush

B Selects the Background brush

U Selects the Unknown brush

M Selects the Missing brush

E Selects the Eraser brush

Right-mouse drag Temporarily draws with the Background brush

Shift-F Selects Fill mode

[ and ] Arrow Keys Sets the size of the current brush

Up and Down Arrow Keys Sets the size of the current brush

Click-Shift-Click Draws a straight line
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Mask Processing

Process (Enter)
Processes the mask.

Refine (R)
Refine mode changes the behavior of the Foreground, Background, Unknown and 
Missing brushes so that they are interactive. As you paint a stroke, Refine mode 
automatically updates the mask or composite.

Note: Refine is only available after you have used the Process button.

Done
Renders EZ Mask’s result back to the host application. In Photoshop, the 

processed mask and foreground are rendered back to their layer. In Lightroom, 

the resulting composite is rendered since it does not support layers.

Note: If the Preview Quality is set to Full, pressing the Done icon exits EZ Mask and 
returns to the host application without rendering.

Rendering is only needed when the Preview Quality is set to a level other than 

Full.

When you press the Done icon, the progress meter pops up until rendering, if 

needed, is completed.
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Processing Keyboard Shortcut

Shortcut Action

Esc Cancels processing

Enter Triggers the Process icon

R Activates Refine mode
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Options
Various EZ Mask options can be set by clicking the Options icon.

Edge Color Estimation
Estimates the color of the foreground in unknown and semi-transparent areas. 

Edge Color Estimation is on by default and prevents fringing to create a 

seamless composite. When disabled, a foreground object with transparent 

edges against a bright or dark background will have bright or dark edges in the 

composite.

Note: If you wish to touch up the mask in Photoshop, you will want to turn Edge Color 

Estimation off.

Preview Quality
Sets the resolution of the Preview Quality. For optimal performance when 

working with large image sizes, you can work faster and use less memory at 

lower Preview Quality settings. You can then switch the Preview Quality to a 

higher resolution to make final adjustments and to check final accuracy. If you 

have previewed your mask at full resolution, no rendering is required when you 

hit the Done button. Preview Quality resolutions are available in 1024 pixel 

increments.

Off On
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Effects
Color correction, image transformation (DVE) and spill suppression can be 

applied to the foreground element being masked and are available within the 

Effect Parameters window.

Note: You can only enable and work with the Effects parameters in the Composite view.

Color Correct
On/Off Checkbox
Turns the color correction on or off.

Hue
Rotates the hue of the image.

Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 

desaturate.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 

darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 

values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

lighten the midtones, negative values darken the midtones.

Temperature
Sets the color of the image to be either warmer or cooler. Dragging the slider to 

the right makes the image cooler (bluer) and dragging the slider to the left 

makes the image warmer (redder).
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Cyan/Magenta
Adds either Cyan or Magenta to the image. Dragging the slider to the right 

makes the image more magenta and dragging the slider to the left makes the 

image more cyan.

Red
Adds or subtracts red from the image.

Green
Adds or subtracts green from the image.

Blue
Adds or subtracts blue from the image.

Spill Suppression
When a foreground object has been photographed against a solid blue or green 

backdrop, the blue or green color can have a tendency to spill onto the 

foreground object. When extracting an object photographed against one of 

these colors, you may find it necessary to remove the blue or green spill. This 

is a process called spill suppression.

Note: You need to view the composite to see the results of the color suppression.

On/Off Checkbox
Turns the spill suppression on or off.

Off On
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Color
Selects whether blue or green is suppressed from the foreground image.

Amount
Suppresses color spill in the foreground.The default value of 100 should be 

sufficient for most situations.

Range
Increases the range of areas that are color suppressed. If color spill is still 

evident, increase this value.

Edge
Suppresses the color spill of the unknown edge areas to the color gray. This is 

useful for edges that contain a lot of neutral transparency like glass reflections.

DVE
The DVE allows you to transform your image using Position, Scale, Rotation, 

and Corner Pin. Why the name DVE? DVE is an acronym for digital video 

effects and refers to a real-time image manipulation device which does pans, 

rotations, flips as well as various hardware-specific effects such as page turns 

or customized wipes. In the film and video post production industry, DVE is 

frequently used in reference to transforming the image in some way.

On/Off Checkbox
Turns the DVE on or off.

Note: When the DVE is enabled, the strokes are hidden. This is because the strokes 
will no longer match up once the foreground element is transformed.
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On-Screen Controls
The on-screen controls allow you to position, scale, rotate, or corner-pin the 

object.

Position
The object’s position can be adjusted by clicking and dragging the center cross-

hair on-screen control.

Scale
Scale can be adjusted by clicking and dragging the line within the circle on-

screen control.

Rotate
Drag on the circle on-screen control to rotate the object.

Corner Pin
There are four cross-hair points around the four corners of the image. By 

clicking and dragging any of the four points, the image can be adjusted.
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Views
Chooses what to display in the Viewer.

Foreground (F2)
Displays the Foreground image.

Note: By default, paint stokes are displayed over the Foreground view. Deselect the 
selected brush to remove the overlay.

Background (F3)
Displays the Background image.
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Mask (F4)
Displays the generated mask.

Composite (F5)
Displays the foreground composited over the background based on the 

generated mask. If a background layer was not present at the time EZ Mask 

was applied, the foreground is placed over a solid color. 
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View Keyboard Shortcuts

Shortcut Action

F2 Selects the Foreground view

F3 Selects the Background view

F4 Selects the Mask view

F5 Selects the Composite view

Left / Right Arrow Keys Cycles through the different views
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Viewer Controls
At the top of the EZ Mask window, there are four viewer controls.

1:1 (H)
Makes the image in the Viewer a 1:1 zoom ratio and shows the actual pixels of 

the image.

Zoom In (I)
Zooms into the image.

Zoom Level
Displays the zoom level as a percentage.

Zoom Out (O)
Zooms the image out.

Zoom to Fit
Fits the image to the EZ Mask window.

Zoom Region
Select the Zoom Region icon and drag select a square region in the Viewer to 

zoom in on that area.
Dfx User Guide    
• 
• 
•
•
•



• 

EZ Mask User Guide  56 

• 
• 
• 
•
•
•

Pan (Space Bar-drag)
Pans the image when the Viewer is zoomed in.

Note: Panning is only available when a portion of the image is cut off by the Viewer 
window.
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Vertical Split Comparison
Compares two images using a vertical split. Whatever you are currently viewing 

is placed to the left of the split. See the table below for what you will see on the 

right side, which can be changed by selecting a different view.

Move your cursor into the image area over the split line and when the cursor 

changes to a double-arrow, click and drag to move the split.

Left Right 

Foreground Mask

Background Composite

Mask Foreground

Composite Foreground
Dfx User Guide    
• 
• 
•
•
•



• 

EZ Mask User Guide  58 

• 
• 
• 
•
•
•

Horizontal Split Comparison
Compares two images using a horizontal split. Whatever you are currently 

viewing is placed above the split. See the table below for what you will see 

below the split, which can be changed by selecting a different view.

Move your cursor into the image area over the split line and when the cursor 

changes to a double-arrow, click and drag to move the split.

Top Bottom 

Foreground Mask

Background Composite

Mask Foreground

Composite Foreground
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Zoom/Pan Keyboard Shortcuts

Shortcut Action

I Key Zooms the image in

O Key Zooms the image out

Scroll wheel over image Zooms the image in and out

Space Bar-drag Pans the image

Middle-mouse drag Pans the image

Middle-mouse double click Fits the image in the Viewer

H Sets the Viewer to a 1:1 pixel ratio
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General Controls
The EZ Mask window has a number of general controls.

Done
Closes EZ Mask and renders the result to the host application.

Cancel
Cancels EZ Mask and returns to the host application.

Reset
Clears all strokes.

Swap Foreground/Background
When using two images, Lightroom may swap the order of the foreground and 

background images when bringing them into EZ Mask. Use Swap 

Foreground/Background so that the image you want to mask is visible.

Status Bar
The Status Bar located at the bottom right of the user interface provides you 

with useful information.

The following status information is displayed.

Color Est
Displays whether or not Edge Color Estimation is on or off.
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Color Corr
Displays whether or not Color Correction is on or off.

Spill Supp
Displays whether or not Spill Suppression is on or off.

DVE
Displays whether or not the DVE is on or off.

Deartifact
Displays whether or not Deartifact is on or off.

Note: The above settings can all be changed by using the Options icon.

Preview Quality Resolution
Displays the Preview Quality resolution.

Percentage
Displays the mask processing percentage. The Percentage field disappears 

when processing is complete.

Time
Displays the mask processing time. The Time field disappears when 

processing is complete.

Size Window
Change the size of the EZ Mask window by dragging the bottom right corner.

Tool Tips
If you hover the cursor over an icon, a tool tip will appear indicating what the 

icon does along with its keyboard shortcut.
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Help
Opens the Help menu.

EZ Mask Help (F1)
Opens EZ Mask On-Line Help.
Dfx User Guide    
• 
• 
•
•
•



• 

Pull-down Menus  63 

• 
• 
• 
•
•
•

 PULL-DOWN MENUS

File

Load Trimap
Loads a previously saved trimap whether it be stroked or filled.

Save Trimap
Saves the trimap whether it be stroked or filled.

Note: If you save the trimap in Refine mode, it will always save an optimized Filled 
trimap.

Preferences
Display

Paint Colors
Foreground

Sets the color of the Foreground brush.

Background

Sets the color of the Background brush.

Unknown

Sets the color of the Unknown brush.

Missing

Sets the color of the Missing brush.

Background Color
When viewing the Composite, this sets the background color. This feature is 

only available if EZ Mask is applied to a single image.

Processing

Deartifact
Blurry artifacts can be generated while attempting to extract objects that have 

drop shadows, similar colors to the background or out of focus edges. 

Deartifact can be used to limit these artifacts.
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Deartifact

Turns deartifact on or off.

Amount

Sets the amount of deartifacting.

Missing Brush
Sensitivity

Sets the sensitivity of the Missing Brush. The higher the value, the more details 

are brought out.

Edit

Undo/Redo
Undo or redo operations. 

View
Foreground (F2)
Displays the Foreground image.

Note: By default, paint stokes are displayed over the Foreground view. Deselect the 
selected brush to remove the overlay.

Background (F3)
Displays the Background image.

Mask (F4)
Displays the generated mask.

Composite (F5)
Displays the foreground composited over the background based on the 

generated mask. If a background layer was not present at the time EZ Mask 

was applied, the foreground is placed over a solid color.

Help

User Guide
Opens the EZ Mask User Guide.
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 KEYBOARD SHORTCUTS

Brush Keyboard Shortcuts

DVE On-Screen Controls

Processing Keyboard Shortcut

Shortcut Action

F Selects the Foreground brush

B Selects the Background brush

U Selects the Unknown brush

M Selects the Missing brush

E Selects the Eraser brush

Right-mouse drag Temporarily draws with the Background brush

Shift-F Selects Fill mode

[ and ] Arrow Keys Sets the size of the current brush

Up and Down Arrow Keys Sets the size of the current brush

Click-Shift-Click Draws a straight line

Shortcut Action

Drag center cross-hair Move the object

Drag line within circle Scales the object

Drag on circle Rotates the object

Drag on a corner cross-hair Corner-pins the object

Shortcut Action

Esc Cancels processing

Enter Triggers the Process icon

R Activates Refine mode
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View Keyboard Shortcuts

Help Keyboard Shortcuts

Zoom/Pan Keyboard Shortcuts

Undo / Redo Keyboard Shortcuts

Shortcut Action

F2 Selects the Background view

F3 Selects the Foreground view

F4 Selects the Mask view

F5 Selects the Composite view

Left / Right Arrow Keys Cycles through the different views

Shortcut Action

F1 Opens EZ Mask Help

Shortcut Action

I Key Zooms the image in

O Key Zooms the image out

Scroll wheel over image Zooms the image in and out

Space Bar-drag Pans the image

Middle-mouse drag Pans the image

Middle-mouse double click Fits the image in the Viewer

H Sets the Viewer to a 1:1 pixel ratio

Shortcut Action

Ctrl(Win)/Cmd(Mac)-Z Undo

Ctrl(Win)/Cmd(Mac)-Y Redo
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